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  Как удалить сканированную страницу в pdf. Как удалить страницу в Adobe Acrobat Pro. Использование CutePDF в Windows

    
 Будем использовать программу Foxit Reader. Она более удобна и менее тяжеловесна, чем Adobe Reader. Скачать программу можно с сайта разработчика http://www.foxitsoftware.com/downloads/
 

Существует версия для Linux.

Выберите язык Russian, вашу операционную систему (OS) и нажмите кнопку Download.
Откройте в Foxit Reader pdf - файл и выберите страницу, которую хотите сохранить как картинку. Страница должна отобразиться на экране монитора. Для сохранения картинки удобно использовать функцию Снимок.

Сначала щелкните по кнопке Истинный размер, чтобы страница предстала в максимальном размере. В меню выберите вкладку Главная и затем щелкните по значку Снимок (значок с изображением фотоаппарата). Подведите курсор мыши к левому верхнему углу страницы. Нажмите левую кнопку мыши (ЛКМ) и, не отпуская кнопку, перемещайте курсор по диагонали к нижнему правому углу страницы. Картинка выделится контуром из тонких пунктирных линий. Отпустите кнопку. Или просто щелкните по странице ЛКМ. Страница выделится синим цветом. Появится окно с сообщением о том, что выделенная область скопирована в буфер обмена. Нажимаем кнопку Ok. Можно выделить только часть страницы.



Если вы используете англоязычную версию, то для получения снимка пройдите в меню по пути Tools -> Snapshot.






Щелкнем по значку Вставить. Картинка из буфера обмена будет вставлена в окно Paint"а. Внизу в строке состояния Paint"а проверьте размеры картинки в пикселях. Обычно требуется изменить размеры картинки, например, для вставки на сайт. В меню выберем вкладку Главная и щелкнем Изменить размер. По умолчанию стоит флажок Проценты. Это не очень удобно, установите флажок на пиксели. Отобразятся размеры картинки в пикселях. Введите желаемый размер по горизонтали или вертикали. Второй размер корректируется автоматически, если стоит галка Сохранить пропорции. Щелкаем Ok для сохранения изменений. Осталось самое простое - сохранить картинку в нужном формате. В меню выбираем Файл - Сохранить как. В правой части окна выбираем нужный формат. Я выбираю Изображение в формате JPEG.






Если вы вырезали только часть картинки, то в Paint"е большая часть листа может оказаться незанятой, чисто белой. Это легко исправить. После кнопки Вставить становится доступной кнопка Обрезать. Щелкните по ней и незаполненная часть листа автоматически обрежется до краев изображения. Или подведите курсор к правому нижнему углу незаполненной части листа. Как только появится двунаправленная стрелка, нажмите ЛКМ и, не отпуская кнопки, перемещайте границу листа по диагонали до края изображения. Отпустите кнопку. Теперь откадрированное изображение можно сохранить.

Также и в самом Paint"е есть возможность обрезать картинку. Нажмите ЛКМ и, не отпуская, выделите нужную часть картинки. Станет доступна кнопка Обрезать. Нажмите ее и картинка обрежется до нужных размеров. Останется сохранить ее, как описано выше. 

Также есть возможность Вырезать, Копировать и Повернуть и переместить картинку.

Установка Foxit Reader в Linux


С официального сайта скачайте версию для Linux, например FoxitReader.enu.setup.2.4.4.0911.x64.run.tar.gz. Распакуйте скачанный архив. Для этого щелкните ПКМ по значку архива и в меню выберите Распаковать.



Полученный файл FoxitReader.enu.setup.2.4.4.0911(r057d814).x64.run — это установщик программы Foxit Reader, щелкните по значку и запустится установка Foxit Reader. Затем надо принять лицензию и установка завершится. После установки на рабочем столе появится ярлык программы. Щелкнув по ярлыку, можно запустить программу.

PDF - файловый формат. Предназначен для представления/хранения в электронном виде разнообразной полиграфической продукции - книг и журналов, документации и чертежей, презентаций и т.д. Был разработан компанией Adobe Systems более 20 лет назад. Сказать, что формат pdf популярен - всё равно, что скромно промолчать. Без него никуда! Владельцы машин MAC и PC активно пользуются его возможностями и благами несчётное количество раз в день. В независимости от того, представителями какой профессии они являются, какими увлечениями и хобби одержимы.
 Умение делать поправки в pdf-документе - вырезать/удалять страницы - весьма полезный навык для пользователя. Владея этой нехитрой наукой, он всегда может в сумбурном потоке текстово-графической информации быстро отделить рациональные зёрна мысли от плевел второстепенного.
 Благо, удалить страницу в pdf можно различными способами, в том числе и посредством сервиса онлайн (прямо в браузере!) Давайте ознакомимся с его возможностями воочию.
 Редактор iPDF2Split
 1. Откройте в браузере страничку - «sciweavers.org/free-online-pdf-split» (без кавычек). Или просто сделайте запрос в поисковике - iPDF2Split и перейдите на первый в выдаче ресурс.
 2. Под чёрным информационным блоком найдите настройки и инструменты редактора (заголовок «TryiPDF2New... »).
 3. Убедитесь, что в разделе «PDF»включена радиокнопка «File».
 4. Кликните кнопку «Выберите файл».
 5. В окне «Открыть» перейдите в раздел/папку, в которой хранится файл pdf. Затем выделите его кликом мышки.
 6. Нажмите «Открыть». После этого, рядом с кнопкой «Выберите файл» должно появиться название выбранного документа.
 7. В разделе «Options» включите кликом мышки опцию «Range». В соседнем поле введите номер страницы или диапазон страниц через дефис (например: 5-9), которые необходимо удалить.
 8. Кликните левой кнопкой мышки по большой кнопке «Split» (справа от «Options»).
 9. Подождите немного. Онлайн редактору потребуется 2-5 минут, чтобы справиться с вашей задачей.
 10. По окончанию редактирования, под панелью настроек, появится ссылка «Download PDF». Кликните по ней, чтобы загрузить видоизменённый файл на ПК.
  Удаление в Adobe Acrobat Pro
 ЗапуститеAdobe Acrobat Pro. Загрузите файл pdf, в котором необходимо удалить страницы.
 Если требуется убрать одну страницу(или несколько страниц подряд):
 1. Кликните по ней мышкой. В меню, в окошке, рядом со стрелочками «вверх» и «вниз», должен появиться номер выбранной странички.
 
 2. Откройте кликом мышки панель «Инструменты». Перейдите в раздел «Страницы».
 3. В блоке «Манипулировать страницами» нажмите «Удалить».
 
 4. В окошке «Удалить страницы»:
 
 
 	если хотите убрать из документа pdf одну страницу - включите опцию «Выделенные»;
	если несколько страниц подряд- включите «С:» и укажите в окошках диапазон (с какой по какую удалить).

5. Нажмите «ОК».
 6. Подтвердите действие: в окне «... хотите удалить страницы...?» кликните «Да».
 7. Откройте раздел верхнего меню «Файл», выберите пункт «Сохранить как... ».
 8. Дайте имя отредактированному файлу. Укажите путь (раздел/папку) для сохранения.
 9. Кликните «Сохранить».
 Если вам необходимо удалить несколько страниц выборочно (например:первую, вторую, десятую):
 
 	нажмите иконку «Миниатюры страниц» (самая первая в боковом меню);
	удерживая клавишу «Alt», выделите кликом мышки все необходимые страницы;
	зайдите в меню «Инструменты» и выполните такие же действия, как и в случае удаления одной страницы.

Как вырезать страницы в Adobe Acrobat Pro?
 1. Выделите страницу (одну или несколько).
 2. Откройте: Инструменты >> Страницы>> Извлечь (в блоке «Манипулировать страницами»).
 
 3. В открывшейся панели укажите диапазон извлекаемых страниц (если она одна - укажите её номер дважды: в первом и втором окошке). Включите опцию «Извлечь страницы как... ». Нажмите «OK».
 4. В окне «Обзор папок» укажите путь сохранения вырезанных листов. Кликните «ОК».
 
 Освойте эти простые инструкции, и ваши pdf-документы приобретут самый что ни на есть удобный и комфортный вид. С ними работать станет намного легче!

В этом уроке расскажу как удалить страницу из PDF файла. Этим способом можно удалить любую страницу из файла и поможет нам в этом .

 Для начала берем PDF файл, из которого будем удалять ненужную страницу. Далее открываем браузер Гугл Хром и перетаскиваем этот файл на пустую вкладку.



На этой вкладке автоматически будет открыт просмотр документа. Вверху вы увидите текущую и общее количество страниц, а чуть правее будет характерное меню для работы с файлами такого типа.



Следующим шагом необходимо определиться со страницей, которую мы будем удалять. В моем примере это будет страница под номером 5.



В правом верхнем углу щелкаем по иконке принтера, затем в блоке "Принтер" нажимаем кнопку "Изменить" и в появившемся списке выбираем пункт "Сохранить как PDF".







В блоке "Страницы" ставим точку напротив специального поля и вводим номера страниц, которые должны остаться в сохраняемом документе. Для этого указываем первый диапазон до 5 страницы, далее ставим запятую и указываем второй диапазон с 6 страницы и до последней (также, через запятую, можно указать отдельные страницы). У меня получилось: 1-4, 6-235. В конце нажимаем кнопку "Сохранить", указываем название для нового файла и место, где он будет располагаться.



Если сейчас открыть новый PDF файл, то можно заметить, что в отличие от исходного, в нем не будет хватать 1 страницы.



Поздравляю, теперь вы знаете как легко, без установки дополнительных программ, удалить страницу в PDF файле.

 В сегодняшнем уроке я расскажу как вставить формулу в Word. На самом деле существует несколько способов это сделать и по возможности я постараюсь рассмотреть их все.

 Сегодня расскажу как решить проблему, когда в Excel столбцы обозначены цифрами. Ситуация может быть для многих знакомой. Вы открываете файл Excel и в подписях столбцов вместо букв стоят цифры. Адреса в этом случае имеют не совсем привычное написание R1C1, R1C3 и т.д.

 В этой статье расскажу как удалить дубликаты в Excel
. Рассматривать будем самый простой штатный способ, который появился начиная с Excel 2007.


Вам понадобится
 	- документ в формате pdf;
	- одна из перечисленных программ:
	- Adobe Acrobat Professional,
	- Adobe Reader,
	- PDFCreator,
	- Pdf995 Printer Driver,
	- «Фотошоп».

Инструкция
 Чтобы «вытянуть» страницу из файла в формате PDF, проще всего сохранить копию нужного документа и при помощи функций редактирования выделить и удалить их, оставив только необходимые.
 В программах Adobe Acrobat Professional или Adobe Reader в меню «Файл» выберите пункт «Печать», укажите нужные страницы, формат, параметры печати и путь сохранения файлов.
 Также для этих целей можно воспользоваться специальными программами-принтерами, предназначенными для конвертирования pdf-документов. Эти программы позволяют создать в систему компьютера виртуальный принтер, который мгновенно превращает отправленный для печати документ в pdf-формат. В интернете их достаточно. Скачайте любую и пользуйтесь ей по мере необходимости. Например, неплохо в этом плане зарекомендовали себя PDFCreator, Pdf995 Printer Driver.
 Скачайте и установите одну из программ, после чего отправьте на нее для печати необходимый pdf-файл. Затем в параметрах печати отметьте номера тех страниц, которые необходимо сохранить в документе. Страницы, которые нужно удалить, не указывайте. После этого откройте созданный таким образом рdf-документ и проверьте правильность данного метода. Ненужные вам страницы не войдут в файл, что и требовалось сделать.
 Еще в качестве дополнительного варианта можно использовать программу «Фотошоп». Для этого перетащите документ в программу. Затем в открывшемся окне выберите нужную вам страницу. Сохраните ее отдельным файлом и пользуйтесь.
 Также можно попробовать сделать скриншот нужной вам страницы документа. Но в этом случае страница файла сохранится в формате изображения.
 Источники:
 	как в pdf документе удалить страницу

 Все мы любим поснимать видео для домашнего архива. Зачастую на наших видео появляются ненужные детали – или в начале, или в конце, или в тот момент, когда мы ждем этого меньше всего, непосредственно в процессе съемки кульминации видео. Из-за этого нам нужно разбить фильм на части и вырезать ненужное. Это возможно с помощью простейшего редактора Windows Movie Maker, который позволяет разбивать фильм на части и удалять ненужные фрагменты.
 Вам понадобится
 	- Компьютер
	- Windows Movie Maker

Инструкция
 Откройте Windows Movie Maker. Откройте папку «Пуск» и найдите его в меню «Стандартные». Если вы не можете его , запустите поиск, а ключевой фразой выберите «Windows Movie Maker». После того, как вы найдете его, запустите Windows Movie Maker.
 Запустите фильм в этом окне. Выберите кадр, на котором вы хотите разделить фильм, и нажмите на кнопку «пауза». В случае, если вам трудно в живом времени поймать этот момент, воспользуйтесь покадровой перемоткой.
 В полосе прокрутки внизу у вас появится два фильма. Удалите тот, который вы хотите удалить или сохранить как вторую часть, после чего нажмите на кнопку «Публикация в выбранном месте» - «Данный компьютер». Выберите параметры сохранения и имя файла.
 После сохранения файла нажмите на кнопку «отменить», затем удалите тот файл из полосы прокрутки, который у вас уже сохранен. Сохраните вторую часть так же, как сохраняли первую.
 Обратите внимание
 Ни в коем случае не прерывайте процесс сохранения, программа может зависнуть и потерять все данные!
 Полезный совет
 Используйте максимальное качество при сохранении и параметры, которые были по умолчанию – так вы избежите потери качества.
  Файлы большого размера бывает удобно разделить на несколько частей поменьше, например, для отправки по электронной почте. Это можно сделать, используя программу-архиватор с поддержкой многотомных архивов (RAR, ZIP, ACE, ARJ).
 
 Инструкция
 В появившемся окне задайте имя создаваемого архива (по оно совпадает с именем исходного файла), архива RAR или ZIP и частей (томов), на которые будет разбит архив.
В списке «Разделить на тома размером (в байтах)» есть предустановленные, наиболее популярные, размеры файлов, но можно ввести и любую другую величину (в примере было введено 20 000 000 байт для исходного файла объемом 65 648 451 байт).
Подтвердите выбор нажатием кнопки «ОК» и дождитесь окончания процесса архивации. В итоге, вы имеете файл-архив «разрезанный» на несколько частей.
 
 Видео по теме
 
 Источники:
 	Как разрезать видео на части в бесплатной программе MKVtoolnix

 Самый простой способ упорядочивания содержимого компьютера - сортировка документов и любых других файлов по папкам на различных носителях. Именно так запрограммированы действовать все компьютерные программы. Однако не только программному обеспечению, но и живым пользователям такая возможность не бывает лишней.
 
 Инструкция
 В левой панели проводника дерево папок, по которому вам нужно перейти в ту из них, в которой наметили создание новой. Здесь можно перемещаться не только по папкам, но и по дискам вашего компьютера, если их несколько. А если ваш компьютер является частью локальной сети, то можно заглянуть и в чужой компьютер. Правда, по умолчанию на чужих компьютерах для посетителей извне доступна лишь одна общая папка.
 Щелкните по нужной папке, чтобы получить доступ к содержимому. В правой панели появится список файлов.
 Теперь вам надо щелкнуть правой кнопкой мыши по свободному пространству правой панели проводника – где-нибудь между иконками файлов или ниже всего списка. В результате появится новое меню – это меню правой кнопки обычно называют «контекстным». Одним из пунктов в контекстном меню будет «Создать». Наведите на него курсор мыши и увидите список всего, что вы можете создать в этом месте. Самым первым пунктом здесь будет именно то, что вам нужно - «Папку». Щелкните - и папка будет создана.
 Каждая папка должна иметь собственное имя, по умолчанию все вновь созданные папки компьютер предлагает назвать именем «Новая папка». Вы можете изменить это имя сразу или позже.Если сразу, то после щелчка по пункту создания новой папки вы можете просто начать печатать нужное название, а закончив, нажать Enter и название будет закреплено за этой папкой. Если позже, то нажмите Enter после создания новой папки и за ней будет закреплено имя «Новая папка». Чтобы позже изменить его - щелкните правой кнопкой, выберите в контекстном меню пункт «Переименовать» и начинайте печатать новое название. По завершении нажмите Enter.
 Видео по теме
 
  AVI является одним из самых распространенных форматов хранения цифрового видео. Записи с видеокамер, TV-тюнера, ролики, загружаемые из интернета, в большинстве случаев представлены именно в данном формате. Поэтому у многих пользователей персональных компьютеров так часто возникает вопрос о том, как разбить avi файл на части. Разбиение видео на фрагменты может потребоваться при подготовке презентаций, создании домашнего видеоархива, монтаже ролика из нескольких видеофайлов. При помощи программы Virtual Dub можно решить данную задачу за минимальное время.
 
 Вам понадобится
 	Бесплатный универсальный редактор видео VirtualDub 1.9.9, доступный для загрузки на сайте virtualdub.org.

Инструкция
 Откройте avi файл, который необходимо разбить , в VirtualDub. Для этого выберите на пункты "File" -> "Open video file..." в главном меню приложения. Или же нажмите Ctrl+O. В диалоге выбора файла перейдите в нужную директорию, выделите файл в списке и нажмите кнопку "Открыть".
 
 Активируйте режим копирования -потока без изменений. В меню приложения выберите пункт "Audio" и отметьте элемент "Direct stream copy". Режимы непосредственного копирования видео и аудио потоков предотвращают обработку avi файла, что позволяет разбить его на части максимально быстро и без какого-либо ухудшения качества.
 
 Установите точку начала первой из частей, на которые разбивается файл. Подвиньте ползунок, расположенный в нижней части окна, на кадр, с которого должен начинаться фрагмент видео. Если первая часть должна начинаться с первого кадра, не двигайте ползунок. Нажмите клавишу Home, либо выберите пункт "Set selection start" в меню "Edit".
 
 Установите точку окончания текущей части видео. Переместите ползунок на кадр, которым должна заканчиваться часть. Нажмите кнопку "End", либо щелкните по пункту "Set selection end" меню "Edit".
 
 Сохраните часть видео как отдельный файл avi. В главном меню приложения активируйте пункт "File", а затем выберите "Save as AVI...". Вместо этого можно нажать клавишу F7. Появится диалог сохранения файла. Укажите в нем путь и имя файла для сохранения. Нажмите кнопку "Сохранить".
 
 Дождитесь окончания сохранения фрагмента видео в файл. В диалоге VirtualDub Status будет отображаться информация о процессе записи файла на диск.
 
 Установите точку начала следующей части разбиваемого файла. Если это необходимо, передвиньте ползунок внизу окна на нужную позицию. Если следующая часть должна начинаться непосредственно за предыдущей, не двигайте ползунок. Нажмите клавишу Home, либо воспользуйтесь пунктами меню "Edit" -> "Set selection start". Перейдите к шагу 5.
 
 Видео по теме
 
 Обратите внимание
 В случае если avi файл содержит аудио-канал с переменным битрейтом (VBR), может потребоваться обработка звука.
 Полезный совет
 Для более точного позиционирования указателя текущего кадра, используйте команды меню Go.
 Источники:
 	Документация по VirtualDub

 Для переноса файла большого размера иногда необходимо разрезание его на части. В этом могут помочь специальные программы и утилиты, которые можно скачать в Интернете. Одной из таких программ является Total Commander, на примере которой рассмотрен процесс разбивки файла на части.
 
 Вам понадобится
 	Total Commander

Инструкция
 Для начала необходимо загрузить программу Total Commander и в ней выбрать подлежащий разрезанию файл. Диалоговое окно программы состоит из двух панелей, в одной из которых необходимо перейти в каталог с находящимся в нем нужным файлом. В другой панели выбираем каталог, в который будут помещаться части разрезаемого файла. Кликнув по разрезаемому файлу, открываем «Файл» в главном меню программы Total Commander. В открывшемся окне контекстного меню выбираем команду «Разбить файл».
 В открывающемся окне «Разбиение» находится выпадающий список «Размер частей», в котором надо выбрать значение необходимого размера частей разрезаемого файла. При выбранном значении «Авто», на приемнике будет использоваться все свободное место. Кликом на кнопку «ОК» подтверждаем процесса разбиения файла. Когда закончится процесс разбиения, части разрезанного файла будут находиться в каталоге-приемнике.
 На продолжительность процесса разбиения влияет объем разрезаемого файла и быстродействие . Размер полученных частей не будет превышать заданную величину. Имена частей будут соответствовать имени разрезанного файла, а - обозначать номера соответствующих частей. К полученным файлам добавляется еще один небольшой текстовый файл, имеющий расширение CRC. Он содержит служебную информацию, которая потребуется для сборки всех частей, в последующем, в один файл.
 Полученные части, а также файл с расширением CRC, копируются по очереди на другой компьютер. Запись файлов должна производиться обязательно в один каталог. Запускаем программу Total Commander на другом компьютере и производим сборку файла. Сборка файла из полученных частей происходит в обратном порядке. В результате сборки мы получим в каталоге-приемнике файл, который будет полностью соответствовать исходному файлу.
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                    Как восстановить забытый пароль Apple ID Как можно узнать логин apple id

                    
                        Apple ID - это идентификатор, который дается каждому пользователю устройства Apple. Обозначение формируется при регистрации в системе, чаще всего он повторяет e-mail адрес, но не всегда.Стоит помнить: если вы знаете пароль и идентификатор, то сможете полу

                    


                


                
                    


                    

                


            





        
    

 
        

            
                
            


            
                
                    

                        Интернет 


                    Google Maps (карты Google)

                    
                        Спутниковая карта мира позволяет быстро перемещаться по всей планете между
любыми населёнными пунктами. Подробная карта мира со спутника на русском языке:
Изучите схематическую карту или переключитесь на карту мира со спутника в
нижнем левом угле карты. С
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                    Компьютер не видит iPhone?

                    
                        Всем привет, уважаемые читатели. В сегодняшнем посте я расскажу вам – какие действия нужно предпринять если компьютер (Windows XP – 10; OS X) не видит вашего Apple устройства iPhone или iPad. Если несколько причин, почему происходит такая неприятная сит
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